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Key Features

Following are some of the key features that make Flare unique. See the online Help for more infor-
mation about each feature.

General
Following are some general key features in Flare.

n XML authoring Even if you do not know anything about Extensible Markup Language
(XML), you can use Flare to create XML content (in Flare's main content editor, the XML
Editor). If you are experienced with XML, you will be able to take advantage of all of the ben-
efits of this structured language in Flare.

n XML everywhere = open file architecture Topics are not the only Flare documents
that use XML. All Flare files are separate XML documents—topics, TOCs, browse sequences,
targets, skins, snippets, glossaries, destinations, condition tag sets, variable sets, and more.
This means that Flare projects are completely open, transparent, and accessible.

n W3C schema compliance Flare content conforms to industry standard schema require-
ments from the World Wide Web Consortium (W3C). Therefore, Flare content can be edited in
the Flare XML Editor, in external editors, or transferred back and forth between the two at
will. Flare’s code adheres to the W3C XHTML Schema specification, making it easy to inte-
grate with other XML or XHTML applications.
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Interface

Following are some key features of the Flare user interface.

n Multiple documents open simultaneously Flare is unique in that you can have mul-
tiple documents open in the interface simultaneously.

E X A M P L E

If you want to work on four topics, two TOCs, and one glossary all at the same
time, you do not have to close one document before working on another. You
can have all seven documents open at the same time. You can even "float" and
move them so that they are placed side- by- side. If you have access to dual
monitors, you can have one document displayed on one monitor and another
document displayed on the second monitor.

n Floating and dockable window panes You can "float" window panes and editors, which
lets you then click and drag them wherever you want in the interface. A window pane can be
attached (or "docked") to the sides, top, or bottom of the program interface.

n Resizable dialogs and drop-down menus All dialogs and even drop-down menus can
be resized by clicking and dragging their edges.

n Window layouts You can save a custom configuration (layout) of your workspace.

E X A M P L E

You might want to use Flare's default layout most of the time. However, when
you are working on creating an index, you want to open the Index window
pane. Furthermore, you may want to move that window pane to a certain
place in the workspace. After you have this element just where you want it ,
you can then save that configuration of the workspace as a layout so that you
do not have to move things around each time you want to work on indexing.

n Enhanced undo and redo Flare's undo and redo functions are enhanced as follows:

l Unlimited You can undo or redo an unlimited number of times, back to the last time
you opened the document, even after you have saved it.

l Multiple buffers Each document in the Flare interface has its own Undo/Redo
buffer. This means that you can undo actions in one document and then switch to
another document and undo actions specific to that file.

l User-friendly interface The name of the action is displayed on the Undo or Redo
button. In addition, you can use the drop-down arrow next to the button to select mul-
tiple steps to undo or redo at once, even resizing the drop-down box as necessary.

MADCAP FLARE



Key Features

- 3 -

XML Editor
The XML Editor is the primary editor that is used in Flare. It provides access to the underlying XML
structure of documents in a comfortable visual authoring environment. This editor is used to enter,
modify, and format the content for topics that users see in the output. Not only is this editor used
for topics, but it is also used for working with master pages and snippets. Although this editor lets
you produce XML files, you do not need to know anything about XML to use it. Following are some
of the key features of this editor.

n Print and Web layout modes The XML Editor lets you work in two different layout
modes—Web or Print. The Web mode is the traditional layout for online use. The Print mode
displays topics integrated with page layouts that you can create. This allows you to see the
margins, headers, footers, etc. that will be used in the print output.

n Structure bars The XML Editor in Flare contains two kinds of "structure bars," which (as
the name suggests) are bars around the topic content that show its structure. Not only do
structure bars let you see the tags and spans in a topic, but you can also perform numerous
tasks by clicking on the individual bars and making a selection from the context menu. These
bars might seem unusual when you first start working in Flare (especially if you are used to
working in another tool), but you will soon find that they can be extremely useful and an inte-
gral part of creating and designing content.

n Markers Flare uses industry-driven markup in content. A marker is a highlighted "flag" that
shows the insertion of certain features in the XML Editor—such as variables, bookmarks,
index keywords, and concepts ("See Also" links). A major benefit of using markers is that they
are deleted when you remove the content containing them. This means that orphan keywords
are not left in the project without a point of reference.

E X A M P L E

Let 's say you insert an index keyword into a topic. Later, if you decide to
delete that topic, the index keyword is also deleted. If markup was not used in
the applicat ion, but rather a separate database was used to hold all index key-
words, you might forget to remove the index keyword after you delete the
topic. Then, when a user clicks the index keyword in the output, the appli-
cat ion will be unable to find the topic.

n Add notes and comments in lists The "Make Paragraph Item" feature lets you add a par-
agraph tag at the end of a numbered or bulleted list item. This allows you to easily add a com-
ment after the item without interrupting the flow of the list. To use this feature, simply click
on the list item, select Format>List>List Actions>Make Paragraph Item(s), and then
press Enter. You can also press CTRL+; (hold down the CTRL key and press the semicolon
key) if you prefer to use a keyboard shortcut.

n Merge lists There may be times when you are creating lists and find that you have two or
more ordered lists (<ol> tags) or unordered lists (<ul> tags) next to each other. If necessary,
you can quickly merge the lists together into one list.
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n Drag and drop table rows and columns The XML Editor allows you to drag and drop
content as necessary. One unique aspect to this is the ability to click individual rows or col-
umns in a table and drag them to new locations in the table.

n Color selection tool When you need to apply color to content, you can easily select and cus-
tomize colors by using Flare's Color Picker dialog. You can even use the "Screen" tool to hover
over any area of your computer screen and click to select the precise color beneath it.

n HTML to XHTML conversion When you attempt to open an HTML file in the XML
Editor, a dialog opens, which guides you through the process of converting that file to
XHTML so that it can be modified in the XML Editor. You can also select Project>Import
HTML Files to import and convert multiple HTML files to XHTML at once.

n Tag-sensitive cursor In Flare's XML Editor, the cursor knows when it is inside or outside
of a tag. By default, the cursor is a bracket when it is located between tags (e.g., inline for-
matting). This bracket cursor faces right ([) or left (]), depending on whether it is inside a par-
ticular tag.

E X A M P L E

Let 's say you have written a sentence, and at the end of the sentence you have
typed the word "Close" in bold font, followed by a period in regular font. Now
you want to add the word "button" immediately after the word "Close," but
you do not want the word "button" to take on the bold font. You hover the cur-
sor at the end of the word "Close." The bracket faces left (]), which tells you
that if you were to begin typing at that location, the next text would also be
bold. So you move the cursor slightly toward the right and the bracket cursor
faces right ([), which tells you that the next text at this location would take
on the regular font of the period. You click the mouse button and type the new
text in regular font.
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Single-Source Publishing

"Single-sourcing" is a fancy term that means something very simple—to produce multiple results
from one source. In Flare, you can make use of single-sourcing in many different ways.

n Global Project Linking You can import content and project files contained in another
Flare project, thus allowing you to maintain the information in one location but reuse it in
any other project. When you use this feature to import files, you can include or exclude par-
ticular types of files (e.g., topics, snippets, style sheets, glossaries, targets), specific individual
files, or files that have certain condition tags applied. Simply use the include/exclude meth-
ods that work best for you.

This is different than a simple import process, because in this case, the imported files remain
linked to the source project. This allows you to make future updates to those files in just one
place—in the source project file. When you perform ongoing imports using your previous set-
tings, Flare recognizes changes to the source files. Therefore, the new files can be brought over,
replacing the outdated files.

E X A M P L E

Let 's say you are working on three different Flare projects. Within those
projects, you might have 35 topics and 50 images that are identical in the
three projects. In addit ion, you might use the same style sheet in each project .
Rather than maintaining three different sets of identical files, you can store
one set of those files and import them into the individual projects when
needed. Here are a couple of options: (1) One option is that you could consider
one of your three Flare projects as the "global parent" for those shared files.
(2) Another option is that you could create a new Flare project (perhaps nam-
ing it "global"); this project could have no other purpose than to serve as a
repository for the shared files across your projects. In other words, you would
not necessarily generate any output from this parent project , but simply use it
as a place to hold your shared information.

When you want to use any of the shared topic, image, or style sheet files from
the global project , you would import them into the child project . This creates
a link between the imported files and those in the global project . Therefore,
when you edit those files in the future, you would do so from the global
project and then re- import the changes (either manually or automatically) to
the other child projects.

n Multiple outputs from one project Flare allows you to generate output in a variety of
online and print-based formats, creating as many different targets as you want from the same
Flare project.

n Condition tags at all levels You can apply condition tags at all levels in Flare—character,
paragraph, file, and more.

n Snippets In Flare, there are multiple ways to reuse content in different places. One method
is to create a snippet. Snippets are pre-set chunks of content that you can use in your project
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over and over. Snippets are used for longer pieces of content that you can format just as you
would any other content in a topic. In snippets you can also insert tables, pictures, and what-
ever else can be included in a normal topic.

n Snippet conditions Snippet conditions are condition tags that you can apply to content
within snippets. With snippet conditions, you can separate certain snippet content so that it
displays in some topics or master pages but not in others. This allows you to use one snippet
for many purposes, rather than having to create multiple snippets. Whereas regular con-
ditions are included or excluded at the target level, snippet conditions are included or
excluded at the topic or master page level.

n Variables Another way to reuse content is to create variables. Variables are pre-set terms
that you can use in your project over and over. They are stored in "variable sets," which can
hold multiple variables. Flare provides you with an initial variable set, but you can add as
many additional variable sets as you like. Variables are used for brief, non-formatted pieces of
content (such as the name of your company's product or your company's phone number).
There are different kinds of variables: (1) those you create, (2) system variables (e.g., date and
time; Chapter, Section, and Volume numbers), (3) Heading variables, and (4) Running Head
variables. Some of these are especially useful for page headers and footers in print-based out-
put.

n Style sheets You can take advantage of cascading style sheets (CSS files) to control the look
of your output in one place. You can apply style sheets to individual topics, or you can use a
"master" style sheet, applying it to all files at the target level or project level. In addition to
using style sheets for topics, you can use separate style sheets in Flare specifically for tables
inserted into topics.

n Mediums for topic styles Let's say you want one style setting (e.g., underline font) to be
used for online output and another setting (e.g., do not underline font) to be used for printed
output. You can use a medium in your style sheet to create different settings for the same
style. When you apply a particular medium to a target, it will be used for that output.

n Table styles A table style sheet allows you to single-source your formatting by setting the
properties in one place and reusing them wherever you insert tables in your project. But what
if you want the tables in online output to look one way and the tables in your printed output
to look another way? Here are two options… Solution #1—Two mediums: This is the rec-
ommended solution. You can have one table style sheet and use a medium to specify different
settings for it—one medium is used for online output and another for print. Solution #2—
Two table style sheets: You can insert a single table at each location, using a special ver-
sion of the table style for print-based output. This solution requires you to have two table
style sheets—one for online and one for print.

MADCAP FLARE



Key Features

- 7 -

n Single-source images Capture is MadCap's screen capture and graphics editing appli-
cation. From within Flare, you can launch Capture, add or insert a new screen capture, and
edit images. Capture contains many unique features that are especially useful for online doc-
umentation authors, including the ability to single-source images in Flare projects. For a sin-
gle image, you can provide one group of settings for online output, and another group of
settings for printed output.

E X A M P L E

You might want to use a resolution of 72 DPI for the image in online output,
and a resolution of 300 DPI for the image in printed output. Rather than cre-
at ing two separate images and using condit ion tags, you can use this feature.

You can also single-source images when resizing them in Flare. This can be done through the
use of styles (applying the settings to many images at once) or local formatting (applying the
settings to one image). When you generate online output, the image will be displayed in one
size, and when you generate print-based output, the image will be displayed in another size.

Note: If you use the "Flare Print Format" feature in MadCap Capture to single-source
your images, you may need to take into account the DPI (dots per inch) setting that you
set for the image in Capture. If you specify a large DPI that is recommended for print out-
put (e.g., 300 DPI), you may notice that the image shrinks when you generate print out-
put. If necessary, you can resize the width and/or height of the image ahead of time in
Capture or later in the Flare project to enlarge the image as necessary for the generated
output. The DPI that you specify will be retained, and you will end up with the image
dimensions that you need.
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Language Support
Following are some of the ways that you can take advantage of language support in Flare.

n Unicode support for all left-right languages Flare is fully Unicode capable, making it
possible to handle the entire world’s Unicode language characters. Flare not only supports
Western European languages, but also double-byte Asian languages, Eastern European lan-
guages, and more.

n MadCap Lingo integration One of the easiest ways to translate a Flare project is for a
translator to open that project within MadCap Lingo, which is tightly integrated with Flare.
Because of this integration, there is no need to transfer localized files outside of the actual
project, which helps prevent content and formatting corruption. In addition, translators can
leverage all previous translations created in other tools by importing Translation Memory
eXchange (TMX) files.

After opening your project in Lingo, a translator can immediately see a list of all of the files
(e.g., topics, snippets, variables), index markers, and concepts that need to be localized.
Then, after translating the content in the Lingo interface, the translator can export the results
to a new Flare project in that language. For more information, please refer to the doc-
umentation provided with MadCap Lingo.

n Multiple interface languages in one product In addition to English, you have the
option of viewing the interface in French, German, or Japanese. All of these languages are
available from the same version of Flare (you do not need to purchase different versions for dif-
ferent languages).

n Localized interface for DotNet Help The MadCap Help Viewer also supports multiple
languages in the interface. Therefore, if you build and distribute DotNet Help, users will be
able to select from the available languages to view the interface for your online Help.

n Localized interface for WebHelp, WebHelp Plus, WebHelp AIR, and WebHelp
Mobile If you are generating output for WebHelp, WebHelp Plus, WebHelp AIR, or Web-
Help Mobile, you can customize skins in other languages so that your users can see your inter-
face in their own language.

MADCAP FLARE
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Page Layouts
A page layout is an element that you can create in your project in order to determine page spec-
ifications (e.g., size, margins) and to apply certain content (e.g., headers, footers, page numbers) to
many (or all) topics in print-based output. Page layouts allow for easy configuration through the use
of content frames, a snap-to grid, dragging and dropping, alignment features, and more. Page lay-
outs are similar to master pages, but are more flexible and easier to use. The general rule of thumb is
that page layouts are recommended for print-based output (when possible), and master pages con-
tinue to be the best method for automatically adding headers, footers, and breadcrumbs in multiple
topics for online output. Another difference between page layouts and master pages is that page lay-
outs can be used for any of the print-based outputs (Adobe PDF, XHTML, Microsoft XPS, Microsoft
Word, Adobe FrameMaker), whereas master pages can be used only for Microsoft Word and Frame-
Maker when creating print-based output.

E X A M P L E

Let 's say you are creating a manual that consists of front matter (e.g. , t it le page,
copyright page, and table of contents), 10 chapters, and an index. Perhaps you want
all of the pages in the manual to measure 8 inches in height and 6 inches in width.
Furthermore, you might want some pages (e.g. , t it le and copyright pages) to con-
tain no headers or footers, while you want the other parts of the manual to contain
header text and page numbers at the bottom. In a situation such as this, you might
create one page layout for your tit le and copyright pages, a second page layout for
your TOC, a third page layout to be used by all of the chapters, and a fourth page
layout to be used by the index. Each page layout might contain the same page size
sett ings, but different page headers and footers.

Like all other files in Flare, a page layout is an XML file. It has an .flpgl extension and is stored in
the Content Explorer under the Resources\PageLayouts folder.
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Importing
Following are some of the ways that you can import files into Flare projects.

n Import legacy documentation Flare allows you to import existing documentation in the
following formats:

l RoboHelp projects You can import RoboHelp projects (MPG, XPJ files).

l HTML Help projects You can import Microsoft HTML Help projects (HHP files).

l HTML Help files You can import Microsoft HTML Help files (CHM files).

l Word documents You can import Microsoft Word documents, including DOC,
DOCX, and RTF files. Flare tightly integrates with Word (including Word 2007), using
modern XML data flow techniques and leveraging the Microsoft XML Schema for Office
documents. This allows for superior content fidelity during import.

l FrameMaker documents You can import Adobe FrameMaker documents, including
BOOK, FM, or MIF files. Because you can import the source FrameMaker BOOK and
FM files (rather than just MIF files), Flare has full access to FrameMaker variables, con-
ditionals, auto-numbering, and so on. This means that those features are converted to
Flare seamlessly.

l DITA file content In Flare you can import content from files that have either a .dita
or .ditamap extension. You can start a new project by importing DITA file content, or
you can import DITA file content into an existing project. When DITA file content is
imported, the DITA elements are converted to their equivalents in the Flare XHTML
environment. For example, formatting elements are converted to style classes, and
<resourceid> elements inside <prolog> elements are converted to context- sensitive
Help IDs.

l HTML files You can import HTML files and convert them to XHTML by using the
Project>Import HTML Files option.

l XHTML files You can import XHTML files.

n Import projects from source control If you are using a source control application that is
integrated with Flare, you can import an existing Flare project from the source control tool.
You might use this method, for example, if you are working on a multi-author project and
another member of the team has placed the Flare project in a source control tool such as
Microsoft Visual SourceSafe, Microsoft Team Foundation Server, or Apache Subversion.

n Easy Sync If you import files from another project, copies of those files are placed in the cur-
rent project and a link exists between the imported files and the source files in the parent
project. Also, if you import Word, FrameMaker, or DITA file content into Flare, you can spec-
ify whether a similar link ties those imported files to the source Word, FrameMaker, or DITA
files.

These links mean that future changes to the imported files can be made at the source (i.e., in
your parent project, or in the source Word, FrameMaker, or DITA files). When you make
future changes to the source documents, those files can be re-imported into the project so that
they are included in the current project's output. You have the option of re-importing these
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files manually. However, you can also tell Flare to do this for you automatically when you
attempt to generate the output. This is known as "Easy Sync."

The Easy Sync option is labeled Auto reimport before 'Generate Output' and is located
in the Project Import Editor (for Global Project Linking); Import Microsoft Word Wizard and
Word Import Editor (for Word imports); Import FrameMaker Wizard and Frame Import
Editor (for FrameMaker imports); and Import DITA Wizard and DITA Import Editor (for
DITA imports).

n Full style mapping Flare has full style mapping capabilities. For example, if you import
six Word documents, you don't have to worry about six different CSS files being created.
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Output
Following are the output options available in Flare.

Online Output Options:

n DotNet Help This is a Help output format developed by MadCap Software. It was designed
to include the best attributes of Microsoft HTML Help and WebHelp, while filling the holes
left behind by those formats. DotNet Help is designed specifically to support Visual Studio
2005 developers. It includes a freely redistributable viewer (MadCap Help Viewer), as well as
components for the Visual Studio 2005 developer. These components can be dropped into
your Flare project to facilitate context-sensitive Help, embedded Help, and features such as
automated search string communication between the application and the DotNet Help doc-
umentation.

n HTML Help This is an HTML-based Help format that runs on Windows 32-bit platforms
and requires Internet Explorer on the end users' systems. Use HTML Help to create Help for
Windows desktop applications.

n WebHelp This is a Web-based Help format that can run on almost any browser or platform.
Use WebHelp to create Help for the Internet or an intranet, as well as for desktop appli-
cations.

n WebHelp AIR This is a Web-based Help format that is identical to the regular WebHelp out-
put in most ways. However, WebHelp AIR uses direct integration with Adobe AIR, which is
designed to bring Web-related content to a desktop environment by taking Web files and incor-
porating them into a single file to be opened locally, rather than from a server.

n WebHelp Mobile This is an output type that lets you deploy Web-based, XHTML output
to mobile devices. WebHelp Mobile maintains an easy and intuitive interface that fits on a
very small screen. The Home page in WebHelp Mobile output contains navigation links to
access the various panes that you can include: TOC, Index, Glossary, Search, Favorites,
Browse Sequences.

n WebHelp Plus This is a Web-based Help format that is identical to the regular WebHelp
output in most ways. However, WebHelp Plus is designed to work on a Web server running
Windows XP, Windows Server 2003, Windows Server 2008, Windows 7, or Windows Vista. It
also uses Microsoft Internet Information Services (IIS) and ASP.NET. To provide faster search,
WebHelp Plus uses Microsoft Indexing Service (for Windows XP and Windows Server 2003) or
Windows Search (for Windows Server 2008). The benefit of publishing WebHelp Plus output
is that you and your users can take advantage of some advanced features, including searching
of non-XHTML content, faster server-side search, and automatic runtime merging.
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Print-based Output Options:

n PDF Short for "Portable Document Format," PDF is an open file format created by Adobe.
PDF files represent two-dimensional documents in a device-independent and resolution-inde-
pendent fixed-layout document format.

n XPS Microsoft's XML Paper Specification (XPS) is a document format with a markup lan-
guage that is a subset of XAML for Windows Presentation Foundation. XPS is an alternative
to Adobe's Portable Document Format (PDF).

n XHTML book XHTML is a browser-based output type that consolidates project content in
an XML file. It can be viewed online or printed.

n Microsoft Word The output is exported to Microsoft Word in one of the following file for-
mats.

l XML This is the default document format created (if you do not select one of the other
formats in this list).

l DOC You can export Word to the standard DOC format.

l DOCX This is Microsoft Word's platform-independent, open XML format.

l XPS In addition to sending output directly to XPS (as described above), you can gen-
erate an XPS file automatically when building Word output. You can do this by install-
ing a free add-in download from Microsoft.

l PDF In addition to sending output directly to PDF (as described above), you can gen-
erate a PDF file automatically when building Word output. Because Flare supports
Microsoft Vista and Word 2007, you can send Word output to PDF format, even if you
do not have the Adobe Distiller installed.

n Adobe FrameMaker The output is exported to Adobe FrameMaker in one of the following
formats.

l BOOK This is FrameMaker's native book (or "document collection") file.

l FM This is FrameMaker's native single document file.

l PDF In addition to sending output directly to PDF (as described above), you can gen-
erate a PDF file automatically when building FrameMaker output.
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Code Output Option:

n DITA Darwin Information Typing Architecture (DITA) file content is supported in Flare.
DITA is an XML-based markup language with its own schema for authoring, producing, and
delivering technical information. It is a standard of the Organization for the Advancement of
Structured Information Standards (OASIS), and it consists of a set of design principles for cre-
ating "information-typed" modules at a topic level and for using that content in various deliv-
ery modes. In Flare you can generate output that produces DITA files. When you build this
type of output, a DITA map file is generated, with multiple DITA files in it. The XHTML tags
are converted to DITA elements. In other words, although it is considered an "output" from
the standpoint of the Flare process, the end result is actually a collection of "source" files,
which you can later use in another tool (or import back into Flare) to produce the final out-
put.

Batch targets: You can use batch targets to generate and/or publish one or multiple targets in a
batch from the user interface, perhaps scheduled to run at a specific time.

Command line compile/batch process: You can generate targets from your operating system's
command line. Using this method, you do not have to open Flare at all. In addition, this method
allows you to build a single target or all targets in your Flare project in one batch. The best way to
use the command line feature is to create a batch file with the necessary commands in it. Then you
can use a scheduling tool (such as the Scheduled Tasks utility in Windows) to run the batch file
automatically whenever you want. 

The batch target in the Flare interface is similar to the "command line" feature. However, the com-
mand line feature works outside of the Flare interface, is a bit more manual, and does not support
as many processes.
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Project Management And Team Authoring
Flare provides the following features, which can be used to manage your project and enhance team
authoring.

n Source control Because all content and project-level files are stored as separate XML files,
Flare projects are compatible with all source control systems. All files in a project are inde-
pendent of one another, which means that there are no file dependencies that hinder multiple
authors from accessing project files.

Flare also provides integrated support for version control applications. Built-in support is
available for Microsoft SourceSafe, Microsoft Team Foundation Server, and Apache Sub-
version. In addition, the Microsoft Source Code Control API (SCC API) allows you to configure
your project for integration with other version control tools. One of the highlights of this inte-
gration is an instant message/email system, which can be used to quickly send requests to
other authors to check in needed files. This same system allows individuals to check in and
check out files on the fly, saving valuable time for multi-author teams.

n SharePoint integration Flare supports integration with Microsoft SharePoint. If your com-
pany uses Microsoft SharePoint (software that allows organizations to collaborate, share files,
and publish information to the Web), you can connect to a SharePoint server. Doing this
makes it easy to access and edit the SharePoint files from any of your Flare projects. You can
even copy SharePoint files to your project with mappings that let you keep them synchronized
with the source files. In addition, you can publish Flare output to a SharePoint server.
Finally, you can use the SharePoint server to store any kind of template files supported in
Flare so that they can be used by any Flare users in your company.

n External resources One of the ways Flare supports team collaboration is that you can
create mappings to external resources.

The External Resources window pane lets you select and maintain groups of external files
that you want to share among Flare projects. The paths of these files are written to the reg-
istry so they will be available for all your Flare projects.

External resources can be virtually any local or network files that you have access to (e.g.,
images, PDF files, Flare project files). From the External Resources window pane, you can
easily bring external files into a project (i.e., a copy of the file is added to your Flare project)
and keep them synchronized with the source files through mappings.

The external resources feature is ideal for shared files that you expect to change over time
(e.g., logo images, PDFs, style sheets), as opposed to, say, a template file that is simply cop-
ied into your project and changed only in that project.

n Topic reviews and contributions Flare provides for close collaboration between authors
and others through the use of topic reviews and contributions.

l Reviews You can quickly email topics (in review package files) to other individuals for
their feedback and/or changes. Alternatively, you can use SharePoint integration or the
external resources feature to store the review package files. After inserting annotations
(comments) or making changes to a topic with Flare or with MadCap Contributor (for
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non-Flare users), reviewers can send the topic back to you. You can then view those
comments and accept or reject the edits so that they are added to the source file.

l Contributions Authors, developers, or other individuals in your company can use
MadCap Contributor to create new documents and files, which can be incorporated
into your Flare project.

n File tagging You can assign "tags" to topics and any other files in Flare, even folders. You
can use file tags for many different purposes, such as assigning authors or milestones to top-
ics. Flare lets you generate reports based on the tags that are assigned. This makes project
development easier to track, manage, and schedule.

MADCAP FLARE
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Feedback Service Integration
There is a way to get live user feedback on your documentation by means of MadCap Feedback,
which is a live reporting service that can be purchased in addition to Flare. MadCap Feedback pro-
vides cutting-edge Web 2.0 community capabilities and helps you to answer the following types of
questions: What are users looking for? What are users finding? What are users unable to find? You
can then adjust your project accordingly for a better user experience. Best of all, most of the features
in MadCap Feedback are available not only for Web-based Help (i.e., WebHelp and WebHelp Plus),
but also for desktop Help (i.e., HTML Help and DotNet Help).

You have two options when setting up MadCap Feedback.

n MadCap Feedback Server With MadCap Feedback Server, you install the necessary soft-
ware on your own hardware to host the Feedback data. By using the MadCap Feedback Server
Admin, your system administrator can enter the appropriate server information, create the
necessary SQL database, and perform maintenance tasks such as scheduling automated back-
ups of the data. Authors can use the Feedback license keys that are issued as needed for their
various targets and projects. The Flare output files can be hosted on the same server hosting
the Feedback data, but it is not mandatory; the output files can be published anywhere you
like.

n MadCap Feedback Service With MadCap Feedback Service, there is no need to purchase
your own hardware or host the Feedback statistics. MadCap Software does the hosting for
you. This does not mean, however, that you publish the output files to MadCap Software's
server. Instead, you publish the output files to your own server or anywhere else that you
choose. Even if you have attached your online output to a desktop application, you can still
take advantage of the Feedback features. The number of Feedback license keys issued depends
on the number that you purchase.

Following are some of the features of MadCap Feedback:

n Retrieve and incorporate user comments into your online output.

n View topic ratings.

n See search keywords entered by users, including terms that did not return results for readers.

n Add synonyms to enhance search results.

n View multi-color, multi-shape Feedback charts for your statistics.

n Use Feedback Explorer to see and track all reader activity with a user-friendly interface.

Note: The MadCap Feedback Server and Service are purchased separately from MadCap Flare.
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Other Key Features
Following are some additional key features of Flare.

n Accessibility Accessibility has to do with making sure that your documentation can be
accessed by people with disabilities (i.e., individuals who have visual, hearing, and mobility
impairments). Documentation is considered accessible when it is easier for those with dis-
abilities to use and easier to read using assistive technologies such as Microsoft Windows Nar-
rator, Connect Outloud, and JAWS (Job Access With Speech). Flare has several features to
help you ensure that your output is accessible.

n Auto-numbering This is just what it sounds like—a feature where content is numbered auto-
matically. Of course, if you want to create simple numbered lists in topics, you can always
use Flare's quick list drop-down options. But if you want an alternative that is more
advanced and powerful, you can use auto-numbering.

n Auto suggestionWhen you first start typing content, a popup may display below your text
as you type. This is the Auto Suggestion feature, which analyzes text as you type and com-
pares it to other content (e.g., phrases, variables, snippets) that already exists in the project.
This means you can quickly select existing content from the popup so that you do not have to
finish typing it.

n Cross-references A cross-reference is a navigation link that lets you connect text in one
topic to another topic (or a bookmark within a topic). This is somewhat similar to a text
hyperlink. However, cross-references are more powerful in that the links can automatically be
updated based on commands. You can also convert cross-references to elements such as page
numbers for printed output.

You can also take advantage of context- sensitive cross- references, which are especially
designed for generating print-based output. When you use a context-sensitive cross-reference,
the text automatically changes based on the relationship of the link and the target location if
they are on the same page or only one page away.

E X A M P L E

Let 's say you have a cross- reference designed to display the text "See Figure
2.1." If the link and the target fall on the same page, the cross- reference is
updated to display the text , "See Figure 2.1 above" or "See Figure 2.1 below." If
the link and the target are on adjacent pages, the cross-reference is updated to
display the text , "See Figure 2.1 on previous page" or "See Figure 2.1 on next
page." If the document is double-sided with the link on the left page and the
target on the right page, the cross-reference displays the text , "See Figure 2.1
on the facing page."

n Enhanced search In Flare search results are ranked, not listed alphabetically. In addition,
you can create synonyms to enhance future search results for end users.

n Link Viewer In Flare there are many ways that you can "link" one file with another, thus cre-
ating a dependency. Link dependencies are created when you perform tasks such as: inserting

MADCAP FLARE
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a text hyperlink, inserting a picture, applying a style sheet to a topic, and more. The Link
Viewer window pane lets you see what other files a particular file is linked to and from.

n Movie support Mimic is MadCap's movie-making software. From within Flare you can
launch Mimic, insert movie links, edit movies, and preview movies. Because Mimic uses
advanced compression techniques, your movies will be much smaller than they normally
would be if you were to use other movie-making software. This, of course, results in smaller
overall output and faster loading for end users. All video tutorials and movies in Flare’s
online Help were created with MadCap Mimic. You can also insert movies created with other
software.
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n Multiple TOCs You can have more than one TOC in your project. This is especially useful if
multiple authors are working on the same project. One author can work on one part of the
TOC while another author works on a different part of the TOC. You can then link the TOCs
together. Another use for multiple TOCs is multiple languages (e.g., an English TOC and a
French TOC). Yet another use for multiple TOCs is different versions of output (e.g., a TOC
for a "light" version, and a different TOC for a "professional" version).

Note: Please be aware that, for online output, a TOC does not by itself determine which
topics are generated in the output. However, for print-based output, a TOC works more
like an outline and does dictate the content included in the output. A TOC for online out-
put is simply a means by which end users can navigate through your information. If you
want to use multiple TOCs to generate different outputs that include different topics, you
can accomplish this as long as you also make use of Flare's condition tags and targets.

n QR code You can insert a QR code into a content file (e.g., topic, snippet) using the XML
Editor. A QR code is a type of barcode that can be read by devices such as smart phones. The
data encoded in the QR Code can be text, a website URL, an email address, contact infor-
mation, or SMS (Short Message Service, which is used for sending text messages). Basically,
QR codes are a way to bridge the gap between a static print document and searchable, more
detailed online information at your fingertips.

MADCAP FLARE



- 21 -

Index

A
Accessibility 18
Adobe FrameMaker
importing 10
output 13

Adobe PDF 13
ASP.NET 12
Auto Suggestion 18
Auto-numbers 18

B
Batch
output 14

BOOK file 10
Building
batch target 14
targets using command line 14

Bulleted lists See Lists

C
Capture See MadCap Capture
Cascading style sheets 6
Chapters
variables 6

CHM See HTML Help
Classes See Styles
Color
screen 4

Command line
building targets 14

Comments
lists 3

Compiling See Building

Condition tags
content 5
snippets 6

Contributions 15
Cross-references 18
CSS file 6, 11
Cursors
tag-sensitive 4

D
DITA
DITA file 10
DITAMAP file 10
importing 10
output 14

DOC file 10, 13
Dockable windows 2
DOCX file 10, 13
DotNet Help 12
language 8

E
Easy Sync 10
Extensible Markup Language See XML
External resources 15

F
Feedback
MadCap Feedback 17

Files
tags 16

Floating
windows 2

FLPGL file 9
FM file 10



- 22 -

Footers 9
Chapter Number variables 6
Heading variables 6
Running Head variables 6
Section Number variables 6
Volume Number variables 6

FrameMaker See Adobe FrameMaker

G
Generating See Building
Global Project Linking 5
Graphics See Pictures

H
Headers 9
Chapter Number variables 6
Heading variables 6
Running Head variables 6
Section Number variables 6
Volume Number variables 6

Heading
variables 6

HHP file 10
HTML file 4
importing 10

HTML Help 12
importing 10

I
Images See Pictures
Importing 10
DITA files 10
files from projects 5
FrameMaker documents 10
HTML files 10
HTML Help files 10
HTML Help projects 10
RoboHelp projects 10
source control projects 10
topics 10
Word documents 10
XHTML files 10

Indexing services See Microsoft Indexing
Internet Information Services 12

L
Language support
interface 8
Unicode 8
WebHelp 8
WebHelp AIR 8
WebHelp Mobile 8
WebHelp Plus 8

Layouts See Page layouts
Links
viewing 18

Lists
adding notes or comments 3
merging 3

Localization See Language support

M
MadCap Capture
single-sourcing images 7

MadCap Contributor 15
MadCap Feedback 17
MadCap Help Viewer 12
MadCap Mimic 19
Mapping
styles 11

Markers
tags 3

Master pages
Heading variables 6
Running Head variables 6
snippet conditions 6

Mediums 6
Merging
lists 3

Microsoft HTML Help See HTML Help
Microsoft Indexing 12
Microsoft SharePoint 15
Microsoft Team Foundation Server 10
Microsoft Visual SourceSafe 10
Microsoft Windows 7 12

"Footers" through "Microsoft Windows 7"



"Microsoft Windows Server 2003" through "Schemas"

- 23 -

Microsoft Windows Server 2003 12
Microsoft Windows Server 2008 12
Microsoft Windows Vista 12-13
Microsoft Windows XP 12
Microsoft Word
importing 10
output 13

Microsoft XPS 13
MIF file 10
Mimic See MadCap Mimic
Movies
MadCap Mimic 19

Moving
table columns 4
table rows 4

MPJ file 10
Multi-authoring 10, 15

N
Navigation links
cross-references 18

Numbered lists See Lists

O
Output
batch 14
building targets 14
DITA 14
DotNet Help 12
FrameMaker 13
HTML Help 12
Microsoft Word 13
PDF 13
types 5
WebHelp 12
WebHelp AIR 12
WebHelp Mobile 12
WebHelp Plus 12
XHTML 13
XPS 13

P
Page footers 9

Page headers 9
Page layouts
Chapter Number variables 6
Heading variables 6
Running Head variables 6
Section Number variables 6
Volume Number variables 6

Page numbering 9
Paragraphs
lists 3

PDF See Adobe PDF
Pictures
single-sourcing 7

Print-based output
DOC 13
DOCX 13
FrameMaker 13
Microsoft Word 13
PDF 13
table styles 6
XHTML 13
XML 13
XPS 13

Projects
files 5
Global Project Linking 5
importing 5

Q
QR code 20

R
Redo 2
Reviews 15
RoboHelp
importing 10

RTF file 10
Running Head variables 6

S
Schemas
DITA 14
W3C 1



- 24 -

Screen captures See Pictures
Search 18
Section 508 18
Sections
variables 6

Selectors See Styles
SharePoint See Microsoft SharePoint
Single-sourcing 5
images 7

Snippets 5
condition tags 6

Source control 15
importing projects 10
Microsoft Team Foundation Server 10
Microsoft Visual SourceSafe 10
Subversion 10

SourceSafe See Microsoft Visual Source-
Safe

Structure bars 3
Styles 6
mapping 11
mediums 6
style sheets 6

Subversion 10

T
Tables
columns 4
rows 4
style sheets 6

Tables of contents 20
linking 20
multiple 20

Tags
files 16

Targets
building output 14

Team Foundation ServerSee Microsoft Team
Foundation Server

TOCs See Tables of contents
Topic reviews See Reviews

Topics
snippet conditions 6

U
Undo 2
Unicode 8

V
Variables 6
Chapter Number variables 6
Heading variables 6
Running Head variables 6
Section Number variables 6
Volume Number variables 6

Version control See Source control
Videos See Movies
Viewing
links 18

Visual SourceSafe See Microsoft Visual
SourceSafe

Volumes
variables 6

W
W3C 1
WCAG 18
Web Content Accessibility Guidelines See 

WCAG
WebHelp 12
language 8

WebHelp AIR 12
language 8

WebHelp Mobile 12
language 8

WebHelp Plus 12
language 8

Windows
layouts 2

Windows Search 12
Word See Microsoft Word
Word Wide Web Consortium See W3C

"Screen captures" through "Word Wide Web Consortium"



"WYSIWYG Editor" through "XPS"

- 25 -

WYSIWYG Editor See XML Editor

X
XHTML
file 1, 4, 10
output 13

XML 1
file 13

XML Editor 1
Auto Suggestion 18

XPJ file 10
XPS See Microsoft XPS



- 26 -

Index


	Key Features
	General
	Interface
	XML Editor
	Single-Source Publishing
	Language Support
	Page Layouts
	Importing
	Output
	Project Management and Team Authoring
	Feedback Service Integration
	Other Key Features

	Index

